




































































































































MACINTOSH DESKTOP COMMAND SUMMARY 

WORKING WITH DISKS 

To start the computer .............................. ............. .Insert Pascal disk, turn on machine 

To initialize (format) a new disk ................. .. ....... ..... 1) Insert blank disk (after starting computer) 
.................................. ... ............... .. .. .. ... .. ..... .... 2) Click "One-Sided" or ''Two-Sided" or "Initialize" 
........... ... .... ... ............................... ............. .. ..... 3) Type new disk name 

To eject a disk .. .......... ... .. ... .............................. ... Select disk, select EJECT from FILE menu or 
.. .... ........... .......... ............... ... .... ... ... ..... .. ........... Select disk, press or 
...... .... ... .... .......... ..... .... .... .......... ... ........ .... .. ..... Press (internal drive) or 
.. ................. ................ . .. .......... .... .. ....... .. ......... Press (external drive) or 

To remove a disk from desktop (not the startup) ........ Drag disk icon to trash (also ejects the disk) 

To make a copy of a disk ... .......... ... ...... ... ........ ...... 1) Insert the disk in one drive 
... .. ................................................ . .................. 2) Insert a blank (or erasable) disk in the other drive 
........................... . ......... . ............................... .. . 3) Drag source disk icon to destination disk icon 

To lock (write protect) a disk .. .... ...... ....... ... ............. Slide plastic tab to open hole (close to unlock) 

To open a disk window or folder window ................ .... .Double-click icon or 
....... ......................... ...... .. .................. ............... Select icon, then select OPEN from FILE 

WORKING WITH FILES 

To start Macintosh Pascal for creating a program ....... Double-click the Pascal icon or 
.............. .. .............................. .. .. ................. .. .... Select the icon, then select OPEN from FILE 

To open an existing Pascal program .. ... ... ..... ... .. .... .. .Double-click the program icon or 
........ .... .. .... .... .. .............. .... ..... ....... ... ....... ...... ... Select the icon, then select OPEN from FILE 

To select several files at once ...... .. ..... ................... Drag a rectangle around the icons or 
one icon and shift-click the others 

To copy file(s) between disks ...... .. .... . .................... Drag file icon(s) into window of destination disk 

To remove file from disk .... ... .. ... ...... .... .. ............. .. .. 1) Drag file icon into Trash icon 
...... ......... .. ... ........... .......... ................... ... ......... 2) Select EMPTY TRASH from SPECIAL 

To lock or unlock a file .. .............................. ..... .. .... 1) Select icon 
... ... ... ..... .... .... ............ .......... ... ............. .... .... ... . 2) Select GET INFO from FILE 
.. ........ .... ............... . ...................................... .... 3) Click LOCKED box 

PRINTING 

To print the active window ..... .......... ........ .... .... ....... Press 

To print the entire screen .. .. ...... ......... ..... ............... Press leaps 

To print a program from desktop ........................ ..... . 1) Select the program icon 
....... ......... ......... ..... ................. ............ ....... .. .... 2) Select PRINT from FILE 

To print a catalog of files .... ... .... ............................. 1) Select the disk or folder to be cataloged 
.... ... ... ......... ...... ... ......................... ... ................ 2) Select PRINT CATALOG from FILE 



Macintosh Pascal Functions and Procedures 

Screen Management 
HideAll 55, 87 
SetDrawingRect 55 
SetRect 54, 55 
SetTextRect 55 
ShowDrawing 9 
ShowText9 

File Handling 
close 57, 58-63 
Filepos 60, 64 
NewFileName 40, 41, 56-64, 70 
OldFileName 40, 41, 45, 56-64 
open59, 60 
reset 40, 41, 56 
rewrite 39, 56 
seek60 

Input and Output 
Button 70 
DrawChar 14 
Drawstring 12, 14-15, 26 
get 62-63 
GetMouse70 
Note46, 47 
page 68 
put59 
ReadString 13 
reset 40, 41, 56 
rewrite 39, 56 
SaveDrawing 70 
seek60 
WriteDraw 12, 14 

String Handling 
concat34 
copy 35, 51 
delete 35 
include35 
insert 35 
length 34, 51 
omit35,37 
pos34 
ReadString 13 
StringOf 13,14, 26 
StringWidth 13,14, 26 

Miscellaneous 
GetTime53 
Random 8, 24, 25, 69 

Line Drawing 
Line 10, 15 
LineTo 10, 15, 26 
MovelO, 15 
MoveTo 10, 15,26 

Shape Drawing 
EraseArc 12 
EraseOval 12, 15, 31 
EraseRect 12 
EraseRoundRect 12 
FillArc 12 
FillOval 12, 15 
FillRect 12, 27 
FillRoundRect 12 
FrameArc 12, 15 
FrameOval 12, 15, 21,30 
FrameRect 11-13, 26, 54 
FrameRoundRect 12 
InvertArc 12 
InvertOval 12 
InvertRect 12 
InvertRoundRect12 
PaintArc 12 
PaintOval 12 
PaintRect 12, 50 
PaintRoundRect 10, 15 

Pen Control 
HidePen 10 
PenNormal 10 
PenPat 10 
PenSize 10, 15 
ShowPenlO 

Graphics Text 
CharWidth 14 
DrawChar 14 
DrawString 12, 14-15, 26 
TextFace 14, 15 
TextFont 14 
TextSize 14, 15, 26 
WriteDraw 12, 14 

The Mouse 
Button 70 
GetMouse 70 



MACINTOSH DESKTOP COMMAND SUMMARY 

WORKING WITH DISKS 

To start the computer ... ...... ... ..... .................. ... ..... .Insert Pascal disk, turn on machine 

To initialize (format) a new disk ..... ......... .... ......... ... . 1) Insert blank disk (after starting computer) 
.............................. .................. ........................ 2) Click "One-Sided" or "Two-Sided" or "Initialize" 
.... ....... .... ... .. ... .. ....... ........ .... ... .. ... ... .... .. ........... 3) Type new disk name 

To eject a disk .. ........ .. .................. ... ...... . ... .. ... ..... Select disk, select EJECT from FILE menu or 
.. .... .. ............. .. ........ ......... .... .. .... ...... .. ... ............ Select disk, press ~-IShiftl-E or 
........ .......................... .. .. ... ....... .............. .. .. .. .... Press ~-IShi ftl-1 (internal drive) or 
.. ..... .. ... ....................... . ........ ............. .. ..... ........ Press ~-I Shiftl-2 (external drive) or 

To remove a disk from desktop (not the startup) .... .... Drag disk icon to trash (also ejects the disk) 

To make a copy of a disk ............. ....... .. ........ ....... .. 1) Insert the disk in one drive 
.. ... ..... .. ................ .. ................... ..... ........... . .. .... 2) Insert a blank (or erasable) disk in the other drive 
............ ....... .. .... ................. ........... ............ .... ... 3) Drag source disk icon to destination disk icon 

To lock (write protect) a disk ............................. ...... Slide plastic tab to open hole (close to unlock) 

To open a disk window or folder window ... ............... .. Double-click icon or 
............................... ..... ... ........... .. .. . ........ .. ........ Select icon, then select OPEN from FILE 

WORKING WITH FILES 

To start Macintosh Pascal for creating a program ....... Double-click the Pascal icon or 
............................. ...... .... ......... ... . ..... .... ..... .. .. ... Select the icon, then select OPEN from FILE 

To open an existing Pascal program ..... . .. ... ............. .Double-click the program icon or 
............. ................. .................. ........... ............. . Select the icon, then select OPEN from FILE 

To select several files at once ................... ............. Drag a rectangle around the icons or 
···~·· ··· · ·· · · ···· · ·················· · ··················· · ··· ·· ··· · ·· ···Click one icon and shift-click the others 

To copy file(s) between disks ............... .. ..... ... ..... .. . Drag file icon(s) into window of destination disk 

To remove file from disk ............ ... . ......................... 1) Drag file icon into Trash icon 
.... .... ....... ......... ... .... .. ................................... .... 2) Select EMPTY TRASH from SPECIAL 

To lock or unlock a file .... ............ ...................... ..... 1) Select icon 
..... .... .. .... . ...... .. ........ .......... ..................... ....... .. 2) Select GET INFO from FILE 
..... ............. ...... .. ......... .... .................. . .............. 3) Click LOCKED box 

PRINTING 

To print the active window ... .............. ..... .. ..... .. ..... .. Press ~-~-4 

To print the entire screen .. .... ...... .... .............. .. ... .... Press leaps Lookj-~-I Shi ftj-4 

To print a program from desktop .............. .. ........... ... 1) Select the program icon 
.. .... .... .. ........ .. ............. .. ..... ..... .. ......... .. ............ 2) Select PRINT from FILE 

To print a catalog of files .... .. .. .. .. .... .. .. ..... ......... ...... 1) Select the disk or folder to be cataloged 
..... .... . .. ....... ........ .... .. ...... ... .. ..... ... ...... .. ........ ... . 2) Select PRINT CATALOG from FILE 



Still More 
Exercises 

Predefined Record Types 

Interesting, but not particularly useful, since we already have a 
perfectly good way of passing values to FrameRect. * What we really need 
is a way to control the size and shape of windows automatically so we can 
see the entire output from our Frisbee production graph program (Chapter 
5) without manually dragging window frames around. As you might have 
guessed, variables of type Rect are also used as parameters for window­
management routines. Here's a procedure we can add to the Frisbee 
program to size the windows automatically: 

procedure Window_Setup; {Sizes and displays output windows} 
var 
Text_ Window, Drawing_ Window: Rect; 

begin 
HideAll; {Clear the screen.} 
SetRect(Text_Window, 280, 40, 508, 330);{Build text rectangle record.} 
SetRect(Drawing_Window, 2, 40, 279, 330); {and drawing rect. record.} 
SetT extRect(T ext_ Window); {Size and place the text window} 
SetDrawing Rect(Drawing_ Window); {and the drawing window} 
ShowText; {Display the text window} 
ShowDrawing {Display the drawing window} 
end; {procedure} 

In this procedure, SetRect is used to load values into Text_ Window 
and Drawing_Window, both of which are variables of type Rect. These 
two record variables are used in turn as parameters for SetTextRect and 
SetDrawingRect, which set their resllective windows using the values 
assigned to their record parameters. This example puts the drawing window 
on the left of the screen and the text window on the right, so that the two 
together fill the screen. These procedures and predefined record types may 
be used to customize the output from all of your Mac Pascal programs. 

12-18 Defme a variant record Date_Time that stores the time either as military time (0-
23 hours) or as civilian time (AM, PM) and the date as American (month, day year) or 
European (day, month, year). 
12-19 In exercise 11-28 you used three arrays to store values of frequency, amplitude, 
and duration for use by the note procedure. Repeat that exercise using an array of records 
instead of three arrays. 
12-20 Represent a deck of cards as an array of records with suit and value. Write a 
program that shuffles the deck and deals four 13-card bridge hands. Draw the cards using 
QuickDraw graphics. 
12-21 Write a procedure that sizes and shows the Drawing and Text windows. The 
procedure receives two values, the percent of the screen to be used for the text window (0 
to 100) and a code which specifies whether the screen is divided vertically or horizontally. 

* Sharp-eyed readers will note an inconsistency here: FrameRect had four parameters 
(top, left, bottom, right) when we introduced it in Chapter 2, but has only one record­
type parameter when used in this way. Think of this, not as a contradiction, but as a 
convenience. Because type Rect is a variant record, you can treat it as four simple 
variables or one structured variable, depending on your needs and your preference.) 
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Files and Text Processing 

WHEN NIKLAUS WIRTH designed Pascal, sequential file processing was 
the order of the day. But the world moves faster now, and most of today's 
data storage and retrieval applications are better served by direct access files. 
This chapter will show you how to use this important file type that's not 
even mentioned in the Pascal Standard. 

But first we'll look again at external sequential files, filling in some 
of the details we left out in Chapter 8. So if you haven't yet read that part of 
that chapter, now's the time. 

You may remember from Chapter 8 that Macintosh Pascal handles 
external files by associating each file with a file identifier in a reset or 
rewrite statement, like this: 

reset(lnput_File, String_ Var}; 

In that chapter, we introduced OldFileName and NewFileName, powerful 
procedures that tum dialog box input into strings that can be used as string 
parameters of reset and rewrite, respectively. From the program user's 
point of view, these file name procedures allow input in a friendly and 
familiar way. From the programmer's point of view, they're handy because 
they provide what's needed by reset and rewrite in exactly the right format. 

But there are times when you don't want to bother the user for input, 
even if it's only a click of the mouse. Many programs are designed to work 
with specific files every time they're run; there's no reason to ask for a file 
name in those programs when a built-in string constant will fill the bill. To 
use reset and rewrite without OldFileName and NewFileName, you'll need 
to know more about their parameter lists. 

In both reset and rewrite, the file's identifier (the one used inside the 
program) is the first parameter while a string indicating its name and disk 
location is the second. The second parameter can be a string constant, 
variable, or expression. It can be coded as part of the program, entered as 
data, or computed. The string generally contains two pieces of information: 
the name of the disk that contains the file and the name of the file. A colon 
(:) is attached to the end of the disk name so it doesn't run together with the 
file name. (The disk name may be omitted if the file is on the current disk -
the disk on which Mac Pascal resides when it is first opened or the one 
currently selected with the file dialog box - but it's a good practice to 
always include the disk name.) Confused? Some examples should help: 
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rewrite(Output_ File,'mydisk:myfile'}; 
rewrite(Output_File,String_ Variable}; 
rewrite(Output_File,concat(Disk_String_ Var,':',File_String_ Var}}; 



procedure close 

~ 

printer output 

~ 

Making and Using Textfiles 

Reset and rewrite open files so they can be used by your programs; 
the non Standard procedure close does the opposite. Close is used to close 
a file and to disassociate the file identifier from the the actual file. Close has 
one parameter, the file identifier: 

close(Output_File); 

While it's not technically necessary to formally close a file if it's the only 
one you're using, it's a good habit that's especially important when you're 
writing programs with lots of data files. Here's an example (with no 
redeeming social value) that shows Mac Pascal files in action: 

program External_Files; {Create 11 files and write their names to them} 
var 
Output_File : text; {Declare the file identifier.} 
File_Num : integer; 
Disk_Name, File_Name: string; 

begin 
ShowText; 
write(' Please enter file name '); 
readln(File_Name); {Read file name as data.} 
write('Please enter disk name '); 
readln(Disk_Name); 
File_Name := concat(Disk_Name, ':', File_Name); {Compute file name.} 
rewrite(Output_File, File_Name); {Open the file to write.} 
writeln(OutpuLFile, 'This is file O'); {Write file name in the file.} 
close(OutpuLFile); {Close the file so the identifier can be used again.} 
for File_Num := 1 to 9 do {Create 9 files, computing their names.} 
begin 
rewrite(Output_File, concat(Disk_Name, ':File', chr(ord('O') + File_Num))); 

writeln(OutpuLFile, 'This is file', File_Num: 1 ); 
close( Output_ File) 
end; {for} 
rewrite(Output_File, 'File 1 O'); {This file name is a string constant.} 
writeln(OutpuLFile, 'This is file 1 O'); 
close(OutpuLFile) 
end. {External_File} 

Way back in the second hands-on session you learned how to use the 
Preferences window to send your "Output also to the Printer." You'll 
remember, though, that this option sends everything to the printer, 
including prompts and input that's typed during the execution of the 
program. Consequently, our Dear_Mom printout necessarily included 
typed input above the actual letter. 

You can avoid this side effect of the Preferences window by explicitly 
assigning a file to the printer in your program: 

rewrite (Print_File, 'Printer:'); 
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13 Files and Text Processing 

This statement attaches the file identifier Print _File to the printer in the same 
way the rewrites in our last program associated file identifiers to files on 
specific disks in the disk drives. But unlike a disk drive, the printer can't 
contain individual files, so there's no file name after the colon in the string. 
Here, then, is how we could rewrite Dear_ Mom to produce a printout 
unblemished by input prompt and response: 

program Dear_Mom; {This program prints a letter.} 
var 
How_much : integer; 
Print_File : text; 

begin 
HideAll; 
Show Text; 
writeln('Enter the amount:') {Display prompt in text window} 
readln(How_much); 
rewrite (Print_File, 'Printer:'); {Associate identifier with printer} 
writeln(Print_File, 'Dear Mom,'); {Write letter directly to printer} 
writeln(Print_File); 
writeln(Print_File,'Pleasesend me$', How_much: 3, '.'); 
writeln(Print_File); 
writeln(Print_File,'Love,'); 
writeln(Print_File,'Skip'); 
end. 

It's possible to associate other devices, including Keyboard and 
TextWindow, to file identifiers. This may seem unnecessary, since both of 
these devices are Standard I/O files in Mac Pascal, but it's occasionally 
convenient to be able to redirect standard input or output to other devices 
and back again. TextWindow can only be used with the file identifier 
output, and Keyboard with input. But within those restrictions, you can do 
this kind of thing: 

program out(output); 
{The program parameter 'output' is necessary to define the file identifier!} 
begin 

close (output); 
rewrite (output, 'Printer:') 
writeln ('Goes to the printer even though it's a standard writeln.'); 
close (output); 
rewrite (output, 'TextWindow:'); 
writeln ('Goes to the textwindow, just like the good old days.'); 

end. 

In Oh! Pascall, as in Standard Pascal, a file is a sequential file -
period. As you know by now, the elements of a sequential file must be read 
in order, starting with the first one. If you need information from the 
hundredth component in the file, you have to read through the first 99 
before you can get what you're after. 
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Direct Access Files 

H you decide to change something in that hundredth element, you 
can't just switch to write mode and make your corrections. Because a file 
can't be read and written in the same pass, you have to create a new file, 
copy the first 99 elements from the original, write the new version of the 
hundredth, and then copy the remaining elements from the original. 

In cases where many or most of the elements are changed each time a 
file is used (such as when the current balances for all checking accounts are 
updated at the end of the day) this is an efficient way to process files. But 
there are clearly many applications where this kind of processing just won't 
do. H airline reservations were stored on sequential files, the delays in 
ticket lines would be so long that most customers would probably find it 
faster to take the train - or walk. 

Airline clerks clearly need real-time systems that allow for rapid 
updates of individual pieces of information. Direct access files make such 
systems possible. With direct access files, a single component can be guick­
ly accessed, modified, and written back without the necessity of readmg or 
copying the other elements. (Direct access files are often called random 
access files because any randomly chosen element can be quickly accessed.) 
Procedures for allowing direct (non-sequential) access to files are imple­
mented in most modem versions of Pascal; in Macintosh Pascal these 
procedures are open and seek. In addition, many of the standard proce­
dures for working with sequential files can be used with direct access files. 

A call to procedure open opens a file for both input and output and 
establishes direct access. The form of the call is the same as for reset and 
rewrite: 

open(File_ldentifier,String_ Var); 

This procedure opens the file indicated in String_ Var (which can come from 
OldFileName, NewFileName, or the program). 

When open is used with a new file name in the string identifier (as 
from NewFileName), a new file is created with that name. Since the file is 
empty, eof is true and the file window is undefined. H a non-empty file 
exists with the specified name, eof is false and the file window frames the 
first file component. Either way, you can use either put or write to add 
components to the file. 

When used with sequential files, put always places a component at the 
end of the file. With a direct access file, put places the file component at the 
current file position - wherever that might be - and then advances the file 
position one component. Typically direct access files are created initially by 
adding a batch of new records in a sequence using either put or write. 

Once the file has some components, your program can read or change 
any of those components directly without scanning the rest of the file. But 
in order to do that, the program has to tell the computer which component 
it's looking for. It does that with seek, a procedure that effectively says, 
"locate the fifth (or first, or 5678th) component of the file." Each compo­
nent has an associated number, starting with the first component that you 
entered when the file was open. The first component added to a direct 
access file is numbered zero (for reasons that have to do with binary code), 
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13 Files and Text Processing 

the second is component number 1, and so on. The seek procedure allows 
us to specify the identifier of the file and the number of the desired 
component as parameters: 

seek(File_ldentifier, Longint_ Value); 

Seek moves the file window to the file component specified by the 
second parameter (which may be any longint or integer value). Here's how 
seek can be used to move the file window to the end-of-file to add more 
components: 

seek (File_ldentifier, MAXLONGINT); 

When cruising around a direct access file in the file window, your 
program may need to figure out wher it is. The function FilePos returns a 
longint value representing the current file position. It requires one 
parameter, the file identifier. Here's how FilePos can be used to move the 
window ahead 20 frames: 

seek (File_ldentifier, FilePos (File_ldentifier) + 20); 

As this short program shows, direct access files are easy to read 
sequentially: 
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program List_Files; {Lists the contents of a direct access file.} 
var 
Data_File : file of integer; 
Data : integer; 
File_Position : integer; 

begin 
open(Data_File, 'filename'); {Open the file for direct access.} 
while not eof(Data_File) do 
begin 
read(Data_File, Data); 
writeln(Data) 
end {while} 

end. {List_Files} 

It's just as easy to treat a direct access file as a true random access file: 

for File_Position := 1 to 5 do 
begin 
seek(Data_File, random mod FILE_LENGTH); 
read(Data_File, Data); 
writeln(Data) 
end {for} 
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Direct Access Files 

Let's consider a non-random application for direct access files. Al 
Gorithm's Software Distribution Company stocks hundreds of products 
which are sold to computer stores all across the country, mostly through 
telephone orders. Al is trying to computerize the system so that the crucial 
details of each phone transaction- customer number, product number, and 
quantity ordered- can be entered into the computer. He'd like the computer 
to use that information to adjust the product inventory records and to adjust 
the billing information for the store that placed the order. The system has to 
update the appropriate records immediately so Al's salespeople know with 
certainty that the inventory records shown on the screen are accurate. Since 
there are far too many products and customers to allow the records to be 
kept in the computer's internal memory, the best alternative is to keep the 
information in two direct access files: one for all of the customer 
information and one for product information. 

A direct access file is no better than a sequential file, though, unless 
the program has an efficient way to retrieve an individual record without 
searching through the others. Each customer has a unique account number; 
does that help? Let's suppose the account numbers - and only the numbers 
- were stored in an array in the computer's memory. Since the array 
contains only account numbers, it doesn't take up much space in memory. 
And since array searches are much faster than file searches, a complete scan 
of the array can be done without significantly slowing the program's 
response time. What happens when the number is matched in the array? If 
the customer numbers are stored in the array in exactly the same order that 
they're stored in the file, then the array subscript of the matching number is 
the address of the corresponding record in the file. 

In the vernacular, the customer number is the key to the customer file, 
and we're using an array of key values. The same scheme can be used to 
find records in the parts file. Of course, since arrays are kept in the compu­
ter's volatile memory, the information in each array will have to be copied 
to a file when the program isn't being used. If that file is a direct access 
file, it can be easily updated right along with the corresponding master file. 

Let's focus on the algorithm for the order-entry part of the system: 

Read customer key value file into an array 
Read product key value file into an array 
Read customer number 
while customer number is valid do 
Find the customer number position in customer key value array 
Read customer record from customer file at the same position 
Read product number 
Find the product number position in the product key value array 
Read product record from the product file at the same position 
Read order 
Update the inventory field of the product record 
Update the amount owed field of the customer record 
Write updated records to respective files 
Read customer number 

end 
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In Macintosh Pascal: 
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program Order_Entry; {Simple order entry system} 
con st 
ARRAY _SIZE= 1000; {Maximum number of Products and customers} 
type 
Customer_Record =record 
Number : longint; 
Name, Address, City, State_and_Zip: string; 
Balance_ Owed, Credit_Limit: real 
end; 
Product_Record =record 
Number: longint; 
Product_Description : string; 
Unit_Price: real; 
In_ Stock: longint 
end; 
Customer_File =file of Customer_Record; 
Product_File =file of Product_ Record; 
Key_Array = array[O .. ARRAY_SIZE] of longint; 
var 
{Global file identifier variables} 
Customers: Customer_File; 
Products: Product_File; 

{Local variables} 
Product_Array, Cust_Array: Key_Array; 
Cust_Number, Product_ Number: longint; 
Number_Ordered, Total_Products, Total_Cust, Rec_Number: integer; 
Price: real; 

procedure Read_Key_File (var Data_Array: Key_Array; 
{Reads a file of key values into an array.} 
var Number_Read : integer; 
Prompt: string); {Prompt for dialog box.} 

var 
Key_File: file of longint; 

begin 
reset(Key_File, OldFileName(Prompt)); 
Number_Read := O; 
while not eof(Key_File) do 
begin 
read(Key _File, Data_Array[Number_Read]); 
Number_Read := Number_Read + 1 
end; {while} 
close( Key _File) 
end; {Read_Key_File} 



Direct Access Files 

procedure Find_Rec_Number (Key_ Value: longint; 
var Data_Array: Key_Array; 
var Rec_Number: integer; 
Size: integer); 

{Uses a linear search to find the position of a key value in the index array.} 
var 
Found: boolean; 

begin 
Rec_Number := O; 
Found :=false; 
while (Rec_Number <Size) and not Found do 
if Key_ Value= Data_Array[Rec_Number) then 
Found :=true 
else 
Rec_Number := Rec_Number + 1 

end; {Find_Rec_Number} 

begin {Order_Entry} 
Read_Key_File(Cust_Array, Total_Cust, 'Customer Key File'); 
Read_Key_File(Product_Array, Total_Products, 'Products Key File'); 
open(Customers, OldFileName('Customer File')); 
open(Products, OldFileName('Products File')); 
write('Enter customer number '); 
readln(Cust_Number); 
while Cust_Number >Odo 
begin 
Find_Rec_Number(Cust_Number, Cust_Array, Rec_Number, Total_Cust); 
seek(Customers, Rec_Number); 
write('Enter Product number '); 
readln(Product_Number); 
Find_Rec_Number(Product_Number,Product_Array ,Rec_ Number, 

Total_Products); 
seek(Products, Rec_Number); 
write('Enter size of order '); 
readln(Number_Ordered); 
Price:= Number_ Ordered* Products1'.Unit_Price; 
Customers11.Balance_Owed := Customers''.Balance_Owed +Price; 
Products11.ln_Stock := Products11.ln_Stock- Number_Ordered; 
put( Products); 
put( Customers); 
write('Enter customer number '); 
readln(Cust_Number); 
end {while} 

end. {Order_Entry} 

The exercises at the end of this chapter suggest several additions you 
can make to this program to turn it into a complete, working system. 
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13 Files and Text Processing 

A common error with put and get in direct access files is the off-by-one 
error. To make sure you always end up looking at the record you're after, 
remember three things: 

1. Zero is the file position of the first component in a direct access.file. 

2. Put moves the file position forward by one after it writes to the file. 

3. Get moves the file position forward by one before it reads from the file. 

Self-Check Q. What comes out when this program is run? 
Question 

Still More 
Exercises 

program File_Position; 
{Demonstrates how file procedures affect the file position.} 
var 
Play_File: file of integer; 

begin 
open(Play_File, OldFileName('lnput File')); 
write(Filepos(Play_File) : 2); 
Play_File" := O; 
put(Play_File); 
write(Filepos(Play _File) : 2); 
get(Play_File); 
write(Filepos(Play_File) : 2); 
seek(Play_File, O); 
write(Filepos(Play_File): 2); 
Play_File" := O; 

.put(Play_File); 
writeln(Filepos(Play_File): 2); 
end. 

A. 01201 

13-33 We can improve the perfonnance of the Order_EnJry program by sorting the key 
values in their respective arrays so the program can use a binary search instead of a linear 
search to find key values. If we change the order of the records, though, we won't be able 
to use the subscript of either array to point to the file record position. Instead, we'll have 
to include the file position information in the arrays. Each array will become an array of 
two-field records; the first field of each record will be the key value, and the second will be 
the file position number of the corresponding record. Rewrite the order entry program to 
order the key values as they are read from their files and to search the key value arrays 
using a binary search. 
13-34 Write procedures that add customers and products for both the original order entry 
program and for the version modified in 13-33. The advantage of having the key values 
files direct access (even though they are read sequentially) should be obvious. 

64 



Antibugging and Debugging 

13-35 Write procedures that delete customers and products from the order entry system. 
Is it necessary to delete records from the customer and product files? 
13-36 Write a program that uses the order entry files to print an inventory report listing 
the quantity on hand for each product. 
13-37 Write a program that uses the order entry files to print bills for each customer 
whose amount owed is greater than zero. 
13-38 Write a procedure that updates the amount owed for a customer when that 
customer makes a payment. 
13-39 Write a procedure that updates the quantity on hand to allow new shipments to 
be added to the inventory. 
13-40 Work with a team of students to develop a full-featured order entry system 
following the software engineering principles given in Chapter 10 of Oh! Pascal! 
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14 

Collections of Values: The set Type 

THERE'S LOTS OF LEEWAY in the Pascal Standard's definition of the set 
data type. The desi~ers of Macintosh Pascal were generous with sets. 
They made the size limits large enough to handle most any programmer's 
needs, and only placed one small additional restriction on the way sets can 
be used. 

Sets may be of the base type enumerated, boolean, char, and integer. 
All of the following are allowed m Macintosh Pascal. 

type 
Reserved_Words =(program, procedure, function, while, repeat, string); 
Reserved_ Type= set of Reserved_ Words; 
Character_Set =set of char; 
Boolean_Set= set of boolean; 
lnteger_Set =set of integer; 

Amazingly enough, the maximum cardinality of set size in Macintosh 
Pascal is 65535, the full range of type integer. There are, of course, some 
practical limitations, For example, sets of enumerated types can't be that 
large because of memory constraints. And alas, Longint values outside of 
the range of integer may not be members of sets. Still, the size limit on sets 
is so large that you're not likely to find an application where it's a factor. 

And finally, a minor restriction. The null constant "[]'' may not be 
used with the set operators, so you'll occasionally· have to add an extra 
statement. For example, this 

var 
Alpha: set of char; 

If Alpha= 0 then Do_Something; 

would have to be changed to this 

var Alpha, Null : set of char; 
Null:=[]; 
If Alpha= Null then Do_Something; 

in Macintosh Pascal. 
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Abstract Data Structures Via Pointers 

EVERYTHING YOU LEARNED ABOUT POINTERS in Oh! Pascal! 
applies to pointers in Macintosh Pascal. Actually, that's not quite true; Mac 
Pascal isn't quite as restrictive in the way pointers are assigned values. 

From a beginnner's point of view, Standard Pascal's pointer 
restrictions aren't a problem; in fact, they provide important protection 
against costly and frustrating errors. But for advanced programmers, Mac 
Pascal provides two additonal tools for assigning values to pointers: the 
pointer operator (@) and the function pointer. 

The pointer function allows you to create pointers of different types 
that point to the same location. That makes it possible to treat the contents 
of a given location as both character and numeric data within the same 
program, for example. The pointer operator makes it possible to point to 
specific locations in the system's stack, allowing your program to do fancy 
memory referencing tricks. 

Though these two tools are important and powerful additions to the 
experienced programmers toolbox, they're not particularly useful for most 
programming tasks, since they're tricky and potentially dangerous in the 
hands of the untrained. We thought you might want to know about these 
tools for future reference, but we don't recommend that you use them until 
you've mastered the basic pointer operations. 

If you want to learn more about these advanced tools, consult the 
Macintosh Pascal Reference Manuals, experiment with small test programs, 
and keep backups of all your important files tucked away in a safe place. 
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Advanced Topics: Macintosh Pascal and Beyond 

WE DON'T PRETEND to tell you everything you want to know about 
Macintosh Pascal in this introductory guide. In this final chapter we'll pass 
on a few miscellaneous tricks to add to your Mac bag, including a note on 
the page procedure mentioned in the "Everything You Wanted To Know ... " 
Appendix of Ohl Pascall We'll close with a few words on where to go 
from here when you're ready to explore further the world of Macintosh 
programming 

As mentioned in Ohl Pascall, the Standard procedure page is highly 
implementation-dependent. In Macintosh Pascal, page clears the text 
window when it's called without an argument. If the file identifier for the 
printer is included, page advances the printer paper to the top of the next 
page without changing the Text window. An undocumented feature* of 
Mac Pascal causes the printer to advance whenever page is called with or 
without argument. So if you're using page to clear the Text window 
several times in a program, help save trees by turning off your printer. 

page(output); {or} page; {clearsTextwindow} 
rewrite(printer, 'printer'); 
page(printer); {advances printer to the top of the next page} 

As long as we're in the spirit of full disclosure, we want to mention an 
extension of Macintosh Pascal that has all kinds of potential for abuse. fu 
spite of what you read in Oh! Pascall, const, type, var, procedure, and 
function declarations in Mac Pascal may appear in a block in any order, 
subject to just two restrictions: an identifier must still be defined before it is 
referenced and forward referenced pointers must be defmed in the same type 
clause. Consider the following confused program: 

program Non_Standard_Order; 
procedure Print; 

const FIRST= 10; 
begin 

writeln(FIRST, Second) 
end; 

var 
Second : integer; 

begin 
Second:= 20; 
Print 

end. 

*Computer Science terminology for a bug. 
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In obvious violation of the Pascal Standard, the var clause follows the 
procedure declaration. Macintosh Pascal normally allows variables to be 
declared after procedures, but there's another problem here that will keep 
this program from running: Second is referenced in the procedure before 
it's cfefmed in the main program. We could easily avoid the.run-time error 
that will result by moving Second's declaration before the procedure, but 
then we'd be accessing Second as a global variable, opening up the 
possibility of a side effect. So our non Standard positioning of the var 
clause has a hidden benefit: it points out (with an error message) a global 
reference to the variable. 

We'll leave it up to you (and your instructor) to decide whether this 
advantage offsets the possible lack of portability and readability that can 
result from taking advantage of Mac Pascal's relaxation of the order of 
declarations. 

Macintosh Pascal has access to three major libraries of procedures, 
functions, predefined constants, and predefined types. We've used one of 
these - the QuickDrawl library - extensively in this book. The two we 
haven't used are QuickDraw2, the advanced graphics library, and SANE, 
the Standard Apple Numerical Environment library. Unlike QuickDrawl, 
these libraries can't be accessed from a Macintosh Pascal program unless 
they're explicitly requested by the program with a uses clause. This clause 
comes immediately after the program statement. 

program Show_Uses; 
uses Sane, QuickDraw2; 

(Note that uses is a reserved word in Macintosh Pascal.) 
The SANE library is loaded with numerical functions. One useful 

function is random. This function has the same name as the Mac Pascal 
built-in function random. The SANE random function returns pseudo­
random numbers in the range 1 to 231-1. This is a much greater range than 
the built-in random. H SANE is declared in a uses clause then any call to 
random calls the SANE random. instead of the built-inrandom. 

You've been using the mouse as an input device throughout this book. 
H you've wondered how to write programs that can read the mouse, you'll 
be happy to know that it's not difficult. The function Button and the 
procedure GetMouse provide the basic information your programs need to 
accept simple mouse inputs. Button is a boolean function that returns true 
when the mouse button is pressed and false when it is not. Button has no 
arguments. GetMouse returns the vertical and horizontal positions of the 
mouse in the Drawing window. The Getmouse procedure has two integer 
variable parameters which represent the horizontal and vertical positions. 
Here's a simple program that shows how Button and GetMouse can be used 
to create a sort of poor man's MacPaint:* 
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program Magic_Pen; 
{A program for freehand picture drawing} 
var 

X, y: integer; rg~~~~5~il~=~~;; begin ~D * 
PenSize(10, 1 O); 
while true do 
begin 
repeat 
until Button; 
GetMouse(x, y); 
MoveTo(x, y); 
while Button do 
begin 
GetMouse(x, y); 
LineTo(x, y) 
end 

end 
end. 

• • 

Once you've created a mousterpiece with Magic Pen, how can you 
save it to disk? You learned in the appendix how to do ff with the keyboard, 
but wouldn't it be nice if the program had an option for saving built right in? 
The procedure SaveDrawing, when included in a program, saves the 
contents of the drawing window as a picture file that can be accessed by 
MacPaint and other applications. It has one string value parameter, the file 
name. 

SaveDrawing(NewFileName); {Saves the drawing window as a file} 

Unfortunately, there's no place to put SaveDrawing in this program, 
because it's built around an infinite loop. The only way to stop it with the 
Halt option in the Pause menu, and then there's no way to call the 
procedure. So it's back to the keyboard if we want to save our pictures. 

Obviously, this program in its present form isn't going to inspire 
many budding Picassos. To be truly useful as an application, it would have 
to allow for pen size changes, special effects, and saving pictures, among 
other things. And these additional features should be accessible via pull­
down menus in the Macintosh tradition. 

Unfortunately, we don't have the space here to show you how to 
develop this Magic _Pen into a full-blown Macintosh application. It's a big 
jump from Magic_Pen to MacPaint, and it's not a particularly easy jump in 
Macintosh Pascal. If you're interested in taking the leap, £there's plenty of 
reading matter available to help you jump the right direction. Start by 
thoroughly studying the matenal on data structures in Ohl Pascall; a 

*This picture was drawn by Rosemary Johnson using Magic_Pen. All inquiries should be 
directed to the artist. 
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thorough understanding of data structures is essential for Macintosh 
programming. Then read the documentation that comes with Macintosh 
Pascal: The Macintosh Pascal Reference Manual, The Macintosh Pascal 
Technical Appendix, and the InLine documentation that comes on disk. 
InLine is a challenging but powerful procedure that allows you to access 
routines in the Macintosh Toolbox to create your own menus and such. 

If that documentation isn't clear, consult one of the many commercial 
books on Macintosh programming. Mastering the Macintosh Toolbox, by 
David B. Peatroy and Datatech Publications, published by Osborne 
McGraw-Hill, is a particularly accessible book aimed specifically at 
Macintosh Pascal programmers. 

If you're really serious about Macintosh programming, you'll 
probably want a copy of Inside Macintosh, the challenging but definitive 
reference on the subject. 

When you're ready to graduate to writing full-scale applications 
programs, you may want to consider switching from the Macintosh Pascal 
interpreter to a compiler version of Pascal. The Mac Pascal interpreter is 
unbeatable for learning Pascal, and its friendly user interface makes it nearly 
ideal for designing and debugging Pascal programs. (We know one 
professional programmer who develops his programs using Mac Pascal and 
then converts them to whatever language the job requires.) But Macintosh 
Pascal suffers from a lack of speed and an awkward toolbox interface when 
compared with professional development tools. Fortunately, almost 
everything you've learned about Pascal in this book is directly applicable to 
most compiled Pascals. 

Several excellent Pascal compilers are available for advanced 
applications programming on the Macintosh. One in particular stands out as 
a logical next step from Mac Pascal. Lightspeed Pascal, from Think 
Technologies (the same company that developed Macintosh Pascal) has 
most of the friendly features of the Macintosh Pascal user interface and is 
nearly 100% compatible with Macintosh Pascal. 

Whichever language and implementation you choose for your work, 
you'll find that the tools and techniques you learned in Ohl Pascall and this 
book will make your programming efforts more productive and enjoyable. 
Good programming practices work in every language. 

Happy programming! 

16-1. Rewrite Magic_Pen so that it automatically (1) displays the Drawing window at 
the maximum possible size on the screen; (2) draws two square "buttons" in the bottom 
of the Drawing window, one labeled "Save" and the other labeled "Quit"; and (3) 
recognizes mouse clicks inside those square buttons and reacts accordingly. Add buttons 
to change the pen size and pattern or to make other changes to the pen or the picture. 
Use your imagination. Finally, if you're interested in a real challenge, redo Magic_Pen 
using the Macintosh Toolbox routines to create pull-down menus, dialog boxes, and 
other official Macintosh enhancements. 
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Session 1 : Meet Mac Pascal 

LEARNING TO PROGRAM is like learning to swim: reading about it just 
isn't enough. This appendix is designed to give you some hands-on 
experience so you can start writing and running programs as quickly as 
possible. It's divided into two sessions, each of which can be completed in 
an hour or so. The first session, designed to accompany Chapter 1, covers 
the basics of working with a Macintosh and the Mac Pascal environment. 
Session 2 introduces several tools and tricks you'll need for writing longer 
programs; it works best when used with Chapter 2. After you've finished 
these two sessions you'll be ready to strike out on your own. 

If you haven't already, it's time to sit down in front of a Macintosh 
and make things happen. You'll need a Macintosh Pascal program disk, a 
blank 3.5" diskette, this book, and about an hour. If you're afraid of 
computers or worried about your ability to use them, let go of your 
anxieties and have fun! 

(If you're using a Macintosh that's connected to a hard disk or other 
computers in a network, some of the details of operation may vary slightly 
from what's presented here. For example, many machines with hard disks 
will automatically boot - computerese for start up - without having a 
diskette inserted, provided the hard disk is turned on before the computer 
is. And you frobably won't need a Pascal prowam disk at all if you're 
running off o a hard disk or a network. Your mstructor or lab assistant 
should be able to provide you with details.) 

Ready to go? Reach around the left side of the box, and you'll find 
the on/off switch about half-way down the back. Flip it on, and your Mac 
will wake up with a beep and a question mark. (If the screen is too bright 
or too dark for your taste, you can adjust the brightness with the knob 
located directly below the rainbow-colored Apple logo.) 

That little screen picture (icon, in the vernacular) is saying, "Where's 
the disk?" Your Mac needs a disk to tell it what to do. And not just any 
disk will do; it needs a disk with system files on it. The Macintosh has lots 
of very intelligent circuitry built into its memory, but not enough to do 
anything useful. It needs to have the rest of its smarts loaded into memory 
from a disk each time it's turned on; that's what the system files are for. 

So grab your Mac Pascal program disk. Before you insert it, check 
the little square hole in the comer next to the label. If you can see through 
the hole, the disk is locked (write-protected) so the computer can't add to or 
change any of the information stored on it. Since Macintosh Pascal 
occasionally needs to write to the disk in the course of doing its business, 
you'll need to slide the little plastic cover over the hole if it's not already 
there. 

Now insert the disk (metal end first, label side up) in the slot under 
the screen. (Remember: the little metal door on the disk protects it from 
dangerous dust scratches and fingerprints, so don't open it yourself; the 
machine will do it when the time comes.) Gently push it all the way in, 
and the disk drive motor will start whirring or clinking as the disk spins. 
Eventually you'll see a little Mac on the screen smiling as if to say, 
"Thanks." (If you accidentally insert a disk that doesn't have the system 
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files on it, the little Mac will stick its tongue out, the screen will turn black, 
and the disk drive will spit out the disk. No thanks. If that happens, or if 
the disk is rejected and an "X" appears in the tiny disk icon on the screen, 
tum the machine off for a second and try again, making sure you're using 
your Pascal disk, and not your blank one. If it happens again, have your 
disk checked by your lab assistant.) 

After the system has finished booting, you should see a scene that 
looks something like this: 

Ii File Edit lllew Spec1111 

(If someone else has been using your diskette, the screen may not look 
exactly like this. Carry on anyway.) 

You're staring at your electronic desktop (brought to you by an 
important system program called the Finder). This desktop is your work 
space when you're dealing with Macintosh, and you can treat it the way you 
treat any desktop. You can keep it neat and free of clutter, like it is now, or 
lay out your most important work in an organized way, or pile it high with 
notes, folders, disks, and miscellaneous garbage. But before you can do 
anything, you have to learn how to move things around. That's what the 
mouse is for. 

To use the mouse, you'll need a clean space about a foot square on 
your desktop (your actual desktop, not the one on the screen). You'll be 
rolling your mouse around in that area whenever you use your Mac, so 
locate it in the position that's most comfortable for you. Orient the mouse 
so the cable points away from you and roll it around a little, Watch what 
happens to that little pointer(\) on the screen. As the mouse goes, so goes 
the pointer. As you move the mouse around, remember to keep it facing the 
same direction. If it bumps into something or reaches the edge of the desk, 
pick it up and move it to a more roomy location; lifting the mouse doesn't 
move the pointer on the screen. 

Once you get the hang of moving the pointer, move it so that it points 
to the little trash can. Now push and release the mouse button once with 
your finger (this is called clicking), and watch the trash icon change from 

74 



dragging 

desk 
accessories 

Hbout the Finder ••• 

Chooser 
Scrapbook 
Hlorm Clock 
Note Pod 

• I 

Key Cops 
Control Ponel 
Puzzle 

Session 1 : Meet Mac Pascal 

white to black. Try it again with the Pascal disk icon: point to the disk (the 
picture itself, not the "Pascal" label) and click the button once. The can is 
now back to normal, and the disk is now black. This inverted coloration 
(Apple calls it highlighted) indicates that you have selected the disk icon. 
When you use the Macintosh, you generally select something before you do 
something. 

Point to the trash can and press the mouse button, but this time don't 
let go. Move the mouse to the left with the button held down, and watch an 
outline of the can move with the pointer. When you let go of the button, 
you're letting go of the can, too, and it suddenly relocates where you left 
the outline. In the Macintosh vernacular, this is called dragging an icon. 
Now drag the can back where you found it and let go. You can drag any 
icon around the screen this way. 

Your desk comes equipped with more than a trash can; there are 
several desk accessories hidden inside. Which desk accessories you have 
depends on what's been included in your system file, but you probably 
have a calculator, an alarm clock, a note pad, and a few others. These 
tools are available for your use almost anytime you're using the Mac -- even 
while you're writing a program. To find them, move the pointer to the 
Apple (ti) up in the corner of the screen. Then press the button and watch 
what happens: the apple is highlighted, and a hidden menu suddenly 
appears under the apple. 

This is called a pull-down menu, because you'll pull (or drag) the 
pointer down to the item you want to select. Try it: without releasing the 
mouse button, move the arrow slowly down the list, watching each item 
become highlighted as you roll by. When you reach Calculator, release the 
button. (If you overshoot the calculator, just move the pointer back up to 
Calculator, or roll off the edge of the menu with the button down and try 
again. If you don't have a calculator in your list, pick something else.) The 
menu disappears, the disk whirs, and your personal calculator appears! 

The calculator works just like any good $5 calculator does, except that 
you can use the mouse instead of your fingers to punch the buttons. Try it: 
move the pointer to the 9 and click; move the pointer to the plus ( +) key 
and click; then click 5 three times and click the equal sign (=). There's 
your answer. 

There are four buttons that might not be obvious to you on the 
calculator: the asterisk (*), the slash (/) the E, and the C. Computerists use 
the asterisk to represent multiplication and the slash for division. The E 
stands for exponent , and is used to represent numbers in scientific notation 
(explained on page 11 of Oh! Pascal!). And C clears the calculator's screen 
and memory. 

If you think punching those little buttons with the mouse is awkward, 
you're right. Fortunately, you have another choice: you can just type in the 
numbers and symbols from your Macintosh keyboard or numeric keypad. 
For example, if you type "C6*99=" on the keyboard while the calculator is 
selected, you'll clear the calculator and multiply 6 times 99. 

You can drag the calculator around to different parts of the desk if it's 
ever blocking your view of something else. Just point anywhere on the 
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black bar at the top (except inside that little white square), press the mouse 
button, drag to a new location, and release. When you're through, click 
inside that little square in the upper-left comer, called a close box, to make 
the calculator disappear from the desktop. 

Unless you've got a network, a hard disk, or some other unusual 
hardware configuration, you'll probably be working with two disks: the 
Pascal program disk that contains the interpreter and the system files, and a 
document disk for storing the programs that you write. You can use your 
blank disk for that purpose, but you'll have to get the Mac to recognize it 
first. If you've only got one disk drive, select (with a click) the Pascal disk 
icon and choose Eject (with a drag) from the File menu. The disk should 
pop out like a piece of toast, allowin~ you to insert your blank disk in the 
drive. If you nave two drives, theres no need to eject the program disk; 
simply insert the blank disk in the extra drive. 

If your disk has been used before in a Macintosh, it should show up 
on the screen right under the Pascal disk. When it does, select Erase Disk 
from the Special menu to turn it into an empty disk. 

If you're using a brand new disk the computer will respond with a 
dialog box that looks something like this: 

@ This disk is unre11d11ble: 

D Do you want to initl111ize It? 

( Eject ] ( I niti111ize ] 

initializing Click inside the button that says "Initialize". Why? A new diskette contains 
a diskette no information at all -- just a magnetic surface waiting to be used. But your 

disk drive won't let you store any files on it until you initialize (or format) 
the disk. If you think of the diskette like a freshly-paved circular parking lot 
for programs, initializing the disk is a little like painting stripes and stall 
numbers on the pavement so the parking lot attendant will be able to easily 
park and unpark the files. 

If the dialog box has buttons labeled "One-Sided" and "Two-Sided" 
instead of an "Initialize" you're working with a double-sided disk drives. If 
your disk is certified as double-sided, you can choose either of these 
buttons. The advantage of choosing double-sided is that, as you might 
suspect, you can store twice as much information on the disk. The 
disadvantage is that a double-sided disk can't be used at all in a machine that 
doesn't have a double-sided drive. If you choose single-sided, your disk 
will work in either kind of drive. If your lab has both kinds of machines, 
you might be safer going single. 

Either way, after about a minute, Mac will say 

Please name this disk: 
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Type a name for the disk - George's Disk, or whatever - and click OK. 
After a few seconds, a George's Disk icon will appear on your desktop 
right below the Pascal disk. If you're working with a single disk drive, 
Pascal is now shaded gray, indicating that it's not physically in the drive. 
Your new disk should be black, indicating that it's now the selected icon. 

In general, a window is a tool for looking into something, and most 
of the icons on your desk have windows associated with them. Since your 
new disk is already selected, you can open its window by choosing (with a 
drag) Open from the File menu. When you select Open and release the 
button, the disk icon turns gray (or hollow) as a window zooms out. 

This window, labeled George's Disk, shows us what's stored on the 
disk: nothing. To close the disk window, either select Close from the File 
menu or click the close box in the upper left comer of the window. The 
window shrinks back into the disk icon, which is now back to black, still 
selected and waiting to be used. (If there are any other windows open on 
your desktop, close them now, too.) 

When you're ready, move the pointer to the Pascal disk icon. You're 
going to open it now, but not with the pull-down File menu you used 
before. Instead, with the pointer pointing to the disk icon, double-click the 
mouse button. That's the shorthand way to open something; in this case, a 
window looking into the selected disk. If nothing changed on the screen, 
try again, making sure that the two clicks are close together. When you get 
it right, you should see the disk icon turn hollow as a window opens up, 
showing the contents of the disk. 

The disk window should contain at least two icons: 
• The System Folder, which contains the all-important system files. (You 

can open it and see, if you like.) 
• The Macintosh Pascal Interpreter, which is the tool you'll be using 

throughout this book to create, modify, and run Pascal programs. 
Your disk may also contain some Macintosh Pascal programs created 

with the interpreter. In order to create programs like these, you need to 
open the Mac Pascal interpreter. So do it: select the Macintosh Pascal icon, 
and open it using either the Open menu option or a double-click. (If you're 
working with a single disk drive, your blank disk will pop out and Mac will 
ask you to insert your Pascal disk. This kind of swapping can get tiresome, 
but it's necessary when you're using two disks in a single-drive system.) 
Eventually, you'll see the three windows of the Macintosh Pascal screen: 
the text window, the drawing window, and the program window. 

The text and drawing windows are only useful if you've got a 
program to run, so let's look first at the program window (labeled 
"Untitled" because yourfrogram-to-be doesn't have a name yet.) It already 
contains the skeleton o a Pascal program highlighted in black. You're 
going to replace that program skeleton with FirstRun, the first program in 
Chapter 1 of Oh! Pascal! There are two ways of approaching this task: 
1. Erase the skeleton and start typing FirstRun from scratch. 
2. Replace those words and symbols that aren't in the FirstRun program 

(like the word "Untitled" after "program"), salvaging those parts that are 
(like the word "program"). 
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Both methods yield the same results, but for the sake of simplicity, let's 
start with the first approach. The easiest way to get rid of text in the 
program window is to select it and then hit the !Backspace! key. (As usual, 
first select, then do.) But the prototype program is already highlighted, just 
as if you'd selected it, so you can remove it by simply hitting !Backspace I. 
Try it. 

Your slate should now be blank, except for the flashing vertical bar in 
the comer. This insertion bar shows you where your typing will be 
inserted in the window. (The insertion bar is sometimes called a cursor, for 
CURrent poSition indicatOR.) Typing text on a computer is pretty much 
like using a typewriter, with one major difference: the computer is more 
forgiving. If you make a mistake, or if you change your mind, you can 
correct your program without retyping it from the beginning. Soon you'll 
learn about a number of J?Owerful tools that can make short work of major 
editing jobs. But for this first program you'll only need the one you've 
already used: the !Backspace I key. 

D Untitled 

I 

program FirstRun (output); ~ 
{This is our first program.} 
begin 

whteln('Hello. I love you.') 
end. 

Try typing this program exactly as it's shown here, character for 
character, ending each line by pressing the IReturnl key. Pascal is picky; it 
won't understand what you're telling it to do if you don't use language it 
can recognize, right down to the last semicolon. Special characters can be 
particularly troublesome; make sure to use apostrophes (') rather than 
double-quotes or backward accents to surround the greeting, and curly 
brackets {like these} to enclose the second line. 

But don't take this to mean that you can't make mistakes in your 
typing; the worst that can happen is that you'll have to change something, 
and that's easy. If you hit a wrong key or three, just lsackspacel until the of­
fending characters are gone and retype from that point. I Backspace I can even 
take you back to the previous line to correct errors. 

Be sure to put spaces where they're shown between words and 
characters, but don't worry about indentation and typestyle details in the 
program listing. Each time you press I Return I , the Mac Pascal editor will 
scan the line you just typed, displaying all Pascal reserved words in 
boldface, indenting the line when appropriate, cleaning up messy details, 
and ounttnmfurn.g obvious syntactical problems. 

You might notice that the program listing doesn't exactly match the 
one in the textbook, even after the editor has prettied it up. From Pascal's 
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point of view, the stylistic differences are irrelevant. Line indentation and 
typestyle variations are included to make it easier for humans like us to read 
programs, and different humans have different ideas about what display 
styles make a program most readable. You don't need to make ·any 
decisions on these matters, because the designers of Mac Pascal have 
already decided for you by creating an editor that does the program 
formatting. 

Program FirstRun is Standard Pascal, straight from Chapter 1 of Oh! 
Pascal! It should run just fine using the Macintosh Pascal interpreter, but it 
can be improved by taking advantage of some Mac Pascal extensions. For 
example, you can change your program name from FirstRun to First_ Run. 

In order to edit your program name so it looks that way, you'll need 
to move the insertion bar. Move the pointer over the pro~am window, if 
it's not already there. The pointer will tum into an I-beam (l), allowing you 
to position it precisely between "First" and "Run". Don't confese the /­
beam with the insertion bar. The only thing the I-beam is good for is 
pointing to the place where you want the insertion bar. When you've found 
the right spot with the I-beam pointer, clicking the mouse instantly moves 
the insertion bar there. But until you click, the insertion point is still back 
where you left it. So click once and move the pointer out of the way so you 
can see the insertion bar in its new location. Now when you type an 
underscore character (the shifted hyphen on the top row of the keyboard), it 
goes after First, and Run shifts to the right to make room for it. 

Next, take the unnecessary program parameter "output" out of the first 
line. You could click the pointer after the "t" in "output" and !Backspace I each 
letter away, but there's an easier way. Move the pointer so it's positioned 
anywhere in the word "output", and double-click to select the entire word. 
Now whatever you type will replace that word. You want to replace it with 
nothing, and you learned how to do that when you wiped out the 
highlighted program skeleton earlier: jsackspacel once. Notice how the left 
parenthesis and the semicolon slide to the left to fill the void, and the 
insertion bar is the only thing left where ''output" used to be. A single 
jsackspacel vaporizes everything that's highlighted, whether a single character 
or an entire program. Use it with care .... 

It's time to check your program for errors. Move the pointer to the 
Run menu and select Check. If the program is correct, nothing will change 
on the screen after some audible disk spinning. But if you've followed 
instructions, you're probably looking at a box like this one: 

~ Rn lnualid PROGRAM parameter list has been found. 

The bug is telling you that your program has a bug - one of those errors 
that the editor couldn't find. It's not your fault; we led you here 
intentionally to show you how bugs are handled in Mac Pascal. The 
message in the box is supposed to help you figure out what the problem is. 
But as this example indicates, error messages aren't always as clear as 
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you'd like them to be. Click on the bug (or anywhere in the box) to 
acknowledge the message, and it'll go away, allowing you to look for more 
clues in the program listing. The thumbs-down in the margin tells you 
which line contains the error. The program parameter list referred to in the 
error message is the part inside the parentheses. There's nothing in there, 
so the problem must be that Pascal doesn't allow empty program parameter 
lists. You could solve the problem by putting back the "output" parameter, 
in conformance with standard Pascal. But a better alternative in Mac Pascal 
is to get rid of the parentheses altogether. 

So move your pointer to the space right after the "n" in First_Run, and 
press the mouse button to position the pointer there. Now hold the button 
down while you drag the I-beam across both parens. Let go when you've 
reached the spot between the right parenthesis and the semicolon. (If you 
go too far, just back up or repeat the drag from the beginning.) The 
offending characters should be highlighted in black. IBackspacel them away, 
check your program again, and (hopefully) discover that there are no more 
errors. If the bug stays away, select Go from the Run menu to actually 
make your program execute. If all goes well, you'll see the love note in the 
text window. 

Once you get your program running, try saving it to disk. To save 
this :program, move the pointer to the File menu and select "Save As ... " 
(Notice that Save appears in the menu in a hard-to-read, light gray color. 
Don't try to adjust your set. That's just Mac's way of telling you that 
command isn't operative in this particular situation. Save can only be used 
after you've assigned a name to your program in a previous "Save As ... " 
operation. Dimmed commands in a menu always mean "no can do.") 

After you've selected "Save As ... " from the menu, you'll see a dialog 
box asking you what name you'd like to assign to your saved program. 
The box will look more or less like this, depending on which version of the 
system you're using: 

I lg) Macintosh Pascal 2.0 I 
D rin11f~r jQ. 
L) !nw~j(m~ri1(~r 

<Jt M<I< intosh P<1~c<1! 

~ 
Saue your program as 

II 
lg) Macint •.• 

Eject 

Cancel ( Drive 

®Rs TeHt O Rs Object O Rs Application 
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At the top of the box is a labeled icon representing your Pascal disk. If 
you've got two disk drives, click the Drive button in the dialog box to 
switch to the other disk. If you've got just one disk drive, you'll need to 
click the Eject button to pop the Pascal disk out so you can insert your blank 
disk in its place. Either way, the name of the disk at the top of the box 
should now be the name you gave your blank disk. 

The flashing vertical bar tells you Mac is waiting for you to type a 
name for your soon-to-be-saved program. Most any name will do, but it 
makes the most sense to choose the name that appears in your program 
heading: First Run. (Macintosh file names can have embedded blanks, so 
you don't need to include an underscore character.) When you're done 
typing, you can give Mac the go ahead by pressing I Return I or by clicking the 
button that says "Save." If you're having second thoughts, you can click 
"Cancel" instead. 

When the saving process is completed, the only change on the screen 
is your title on the program window. You saved a copy of the program 
onto a disk; the original is still in the coml'uter's main memory, ready for 
more editing. So let's try adding a little bit of personalized dialog to the 
program. Move the pointer to the end of the writeln statement (after the 
final parenthesis) and click to position the insertion bar there. Now type a 
semicolon(;), press I Return I once, and type these lines, following each with a 
jReturnl: 

writeln('Whaf's your name?'); 
readln(your_name); 
writeln('Bye, ', your_name,'!1 

Notice how each JReturnl moves the last line of the program down. IReturnl is 
like an invisible character that adds a new line to your program. The empty 
line before the end line is just the JReturnl you typed. It's not necessary, so 
JBackspacel it away. 

Now move the pointer so it's positioned after the closing brace at the 
end of the second line. Click to position the I-beam there, press I Return I to 
open a new line, and type 

var your_name: string; 

The Pascal editor will turn this into two lines for you whether you like it or 
not. But it's still the same old declaration, no matter how it's formatted. 

Making changes to existing lines of your program is just about as easy 
as adding new ones. Move the pointer somewhere over the word "love" 
and double-click to select it. Now when you type "don't like", "love" 
vanishes. Now drag the I-beam through "don't lik" and type "lov" to make 
it look the way it did before. 

As you can see, there are lots of ways to select text to change or 
delete: 
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• You can drag the pointer from the beginning to the end of the text to be 
selected. If the text crosses several lines, you can beeline down to the 
end of the selection without crossing all of the characters on each line. 

• You can drag the pointer backwards through text. 
• You can double-click on a word to select only that word. 
• You can double-click on a word and then drag the pointer to some other 

word; both of those words will be selected, as well as every .word and 
character in between. 

• You can triple-click anywhere on a line to select the entire line. 
• You can triple-click on a line and drag to another line to select all lines 

between (and including) those two. 
Try selecting various pieces of this short program using each of these tech­
niques. Don't touch the keyboard, though, or you'll erase the selected text. 

By now, the program looks quite a bit different from the one we 
originally typed and saved. In the interest of truth in advertising, you 
should change the name on the first line from First_Run to Second_Run and 
change the comment so it says "This is our second program." Use any of 
the editing techniques you've learned so far to make these changes. 

When you're done making changes, it should look like this: 

program Second_Run; 
{This is our second program} 

var 
your_name: string; 

begin 
writeln('Hello. I loveyou.'); 
writeln('What''s your name?'); 
readln('your_name); 
writeln('Bye,', your_name, '!') 

end. 

Check it for syntax errors with Check, then run it with Go. The text 
window will say 

D Te1it 
Hello. I love you. 
What's your name? 

and then wait for you to type your name into the string variable your name 
via the readln statement. Press I Return I after you type your name to tell the 
program where the string stops. Your typing and the final pro!µ'8m writeln 
should add two more lines to the text window, so it looks like this: 
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When you're convinced it works, you probably should save it again. Since 
it's already been saved once, you could select Save from the File menu 
instead of "Save As ... ". That tells Mac to save this new program right on 
top of the earlier saved version. The old one is wiped out because you can't 
have two things on a disk with the same name. 

What if you want to keep the earlier version and the new one? All you 
need to do is choose a new name for the second copy (or put it on a 
different disk). The "Save As ... " option in the File menu brings up the 
dialog box again, allowing you to choose a new name and/or disk to save 
the picture, so that you don't wipe out the old one. (When this dialog box 
appears, your original name is highlighted in the name box, but anything 
you type will replace that name. Or you can position the vertical bar and 
edit the title. Or you can leave the name alone and use the buttons to select a 
different disk.) For this exercise, save the program as Second Run, so 
you'll have two saved prowams with different names. 

(When you're buildmg larger programs, it's important to resave your 
work like this often. Since the computer's internal memory depends on a 
steady flow of power, the program you're editing can vanish anytime the 
machine is turned off or the power fails. But if you've saved a copy 
recently, you can always bring that copy in from the disk and start editing 
from that point. Frequent saves also provide you with a way of going back 
to an earlier version in case you accidentally delete or hopelessly mess up a 
large chunk of your program during an editing session. A good strategy for 
protecting yourself against program loss is to select Save every fifteen 
minutes or so when you're originally entering the program, and Save again 
right before you run it. Whenever you make major changes to an existing 
program, "Save As ... " a different name so you can fall back to the old 
version if something goes wrong. When you quit for the day, make a 
backup copy of the program using the techniques described later in this 
session.) 

To make a hard (paper) copy of your program, select Print from the 
File menu. If your Macintosh is directly connected to an Imagewriter 
printer, you'll see a dialog box something like this: 

='m=11="g'=eW=-rit ... e""r ==:=========:;'======~==v=2 3!!.=m K OK D 
Quollty: O Best @ F11ster O Droft 

Poge Range: @ Rll O From: D To: D ( Cancel ) 

Copies: LJ 
Poper Feed: @Automatic 0 Hond Feed 

You can probably ignore most of the options in this box; you most likely 
want one copy of the whole program on automatic (pin-feed) paper. But 
you should know about the three quality choices: 
• Best, which produces clean, easy-to-read copy very slowly. 
• Faster, which prints text that looks almost as good as Best, but at about 

twice the speed. 
• Draft, which prints readable, but ugly, text much faster than either of 

the other choices. 
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There's generally no reason to select Best unless you're trying to 
impress somebody. Faster is a good choice for printing easy-to-read copies 
of your program fairly quickly. But both Best and Faster make a temporary 
copy of the printout on your disk before routing it to the printer, so they 
won't print anything at all if your Pascal disk is full, almost full or locked 
(see the first page of this tutorial). Unfortunately, no error message appears 
under these circumstances; in fact, the computer may display a dialog box 
indicating that the program is being printed! If your program fails to print in 
Faster mode, and you know that the printer is turned on, it's connected to 
the computer, and the printer's Select light is on, try draft mode and 
remember to delete some old files from the disk later. 

(If you're using some other kind of printer, or if you're sharing a 
printer with other Mac users via network, you'll probably need some 
additional instructions from your lab assistant to print your program.) 

That's enough Pascal for a while. Select Quit from the File menu to 
return to the Macintosh desktop. If you're using two disk drives, you 
should see two disk icons on the screen. (If you're using just one, you'll 
need to Eject (File menu) your program disk and insert your document disk 
to make both appear on the screen.) Open both disk windows (with double­
click or the Open menu option) if they aren't already. 

If you only see one window, one's probably hidden behind the other. 
Position the pointer so that it's pointing to the title of the visible window (or 
anywhere along the title bar) and drag. The whole window drags with you. 
Drag it so that it partially reveals the other window. 

Notice the difference between the title bars and borders of the two 
windows: One window is highlighted with more details around the edge 
because it's the active window -- the last window selected (or the window 
containing the selected object). When two windows overlap like this, the 
active window is always "on top." If you want to do anything with a 
window, you must first make it the active window, if it's not already. To 
do that, simply click anywhere in the inactive window. Try it. 

Now make your document disk window active, and notice that it 
contains two icons representing the programs you saved. If these were 
important programs that took hours or days to create, you'd probably want 
to make backup copies immediately, so you wouldn't have to start over if 
something corrupted or destroyed the originals. 

To see how to make backups, drag the pointer from a point above and 
to the left of the leftmost icon to a point below and to the right of the other. 
A dotted rectangle will form between the two points, showing you the area 
of the window you're selecting. When you release the mouse button, the 
two icons inside that rectangle turn black, indicating that you've selected 
both icons at once. This multiple-selection ~ability is handy when you 
want to do the same thing to several items. (The rectangle doesn't need to 
surround the icons completely to select them. If you need to select several 
icons that can't easily be surrounded or touched by a rectangle without 
including some unwanted icons, you can click each of them separately while 
holding down jshittl .) 
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To duplicate these two programs, select Duplicate from the File menu. 
Since both icons are selected, you'll soon see two additional icons in the 
window. These two copies are identical to the original programs except for 
their names. 

This is the quickest and easiest way to make backup copies of your 
programs, but it's not the safest. If you lose your disk, run it through the 
washer in your shirt pocket, or park it next to your magnetic flashlight in 
your backpack, you may lose everything on it, including backup copies. 

It's much safer (if more expensive) to put your backup copies on a 
copying second disk and keep that disk in a safe place. To copy a .Program from one 

between disks disk to another, simply drag its icon from the source disk window to the 
window of the destination disk. Try it: select the First Run and Second 
Run icon(s) by dragging a rectangle around them in and drag them onto the 
Pascal disk. 

When the operation is complete, you'll see a First Run and Second 
Run in both disk windows. Your originals are still on your document disk; 
you just made copies on the other disk. (Whenever you move an icon from 
one disk to another, the original remains undisturbed.) There are two 
situations where this technique won't work: 
1. Mac won't copy the files if it can't find enough space on the destination 

disk. (Solution: delete or move some files from the disk, or use 
another disk You may run into this problem when copying these files 
onto your Pascal disk. If so, don't try to delete the Pascal or System 
files; they're important to keep. If you don't have another disk, just 
carry on.) 

2. If a file already exists on the destination disk with the same name as one 
you're copying, Mac won't proceed with the copy without a warning 
query and a chance to cancel your request: 

Replace items with the same names 
with the selected items? 

n OK D ( Cancel ) 

(Solution: Since two files on a disk can't have the same name, you'll have 
to change the name of one or the other before making the transfer, or else 
say goodbye to one. To change a file name, just click the icon and type a 
new name.) 

You could, in fact, move everything on the disk that way to make a 
backup copy of the entire disk, but there's an easier way: just drag the icon 
representing the disk to be copied onto the icon representing the soon-to-be 
backu:e disk. 

(If you're working with your own hard-earned Pascal disk, you may 
want to copy that disk to protect your inventment against accidental 
whatever. Earlier versions of the Macintosh Pascal interpreter were copy-
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protected so they couldn't be duplicated in this way. Copy-protection has 
been removed from the software to make it easier for you to make extra 
copies of the interpreter on different disks in case something happens to 
your original. Mac Pascal is still copyrighted, though, so those extra copies 
should not be shared with friends. Programming is hard work, and 
complex software like Macintosh Pascal is terribly difficult and expensive to 
develop. When you give away copies of that, or any other, copyrighted 
software, you're stealing from the people who wrote it - and violating 
federal law.) 

The Golden Rule of Sharing Software 

Bootleg unto others as you would have them bootleg unto you. 

There's no point in saving both of these tiny programs on both disks, 
so drag Copy of First Run and Copy of Second Run out of the document 
disk window and into the trash. When your pointer reaches the can, the can 
will tum black, indicating that the selected items are now inside it. Let go of 
the button, and the copies disappear from the window. They should be in 
the trash. Open the can to check, using either of the two can-opener 
techniques you've learned. If you did everything correctly, you should see 
both icons in the Trash window. 

If you're having second thoughts about throwing them away, you can 
drag them out of the trash window and back to their original disk windows. 
(The programs are still on the disks, even though the icons disappeared 
from the window. This feature can come in very handy - even the best of 
us occasionally have to dig through our own garbage.) Or, if you're ready 
to really dispose of them, you can move the pointer up to the Special menu 
and drag it down to "Empty Trash." When you do, the program disappears 
from the trash window, and you're given back the space it occupied on the 
disk. (Normally, it's not necessary to empty your own trash like this unless 
you're in a hurry to get your disk space back. The machine will take care of 
it for you eventually, the next time you open Pascal or when you remove 
your disk and quit.) 

If you just tum off your machine when you're through, you won't be 
able to take your disks with you. What's worse, you won't give the 
machine a chance to take care of last minute diskkeeping details. So each 
time you're ready to quit, pull down the Special menu and select Shut 
Down. (If you're using a version of the system that doesn't include the 
Shut Down command, just select and eject both disks instead, and ask your 
lab assistant about updating your system file.) Mac will eject your disk, 
forget everything you did this session, beep, and ask if you want to start 
over by bringing back the "Where's the disk?" icon. 

If nobody's waiting to use the machine, tum it off and call it a day. 
Next time you'll learn some advanced editing and debugging techniques to 
make your programming easier and you'll see how to write programs that 
draw pictures in the graphics window. 
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For this session you'll need your Mac Pascal disk and the document 
disk you created in your first hands-on session. This time we'll cover 
several new topics: manipulating windows, editing longer programs, and 
organ-izing your files and disks. As usual, this tutorial will work best if 
you do it rather than read it. If some of the more advanced material seems 
over-whelming, let it go and remember that it's here when you need it. 

To get started, turn on your Mac and boot it with your familiar Pascal 
program disk. Then insert your document disk in the other drive (if you 
have one, or in the main drive, after ejecting Pascal, if you don't). If you 
left your document disk window open the last time you ejected the disk, it 
should automatically open when you start up this time. If it doesn't, open it 
(with a double-click or the Open command in File). The Second Run icon 
should be there, where you left it. 

Open that icon just like you opened the disk; Mac will recognize it as a 
Pascal program, open Pascal, and bring Second Run into the program 
window, ready to edit or run. You're going to use Second Run as the raw 
material for building a longer, more interesting program. But first, a word 
from the Instant window. 

Select Instant from the Windows menu. The Instant window will 
appear, waiting for you to type a Pascal command. Type 

writeln ('Hello again.') 

That phrase should appear in the text window as soon as you click "Do it." 
No check, no run; just instant results. I Backspace I that writeln statement away 
and try another. Type 

HideAll 

Now push "Do it." Poof! HideAll is a powerful Macintosh Pascal 
procedure for automatically closing all the windows on the screen. You 
could, of course, close these windows manually with their close boxes, but 
HideAll works anywhere inside a program, allowing you to clear the screen 
automatically. 

with 
Select Instant from the Wmdows menu again, and replace HideAll 

ShowText; 
ShowDrawing 

Now you can resurrect the Text and Drawing windows by pressing "Do it." 
Bring back the program window manually by selecting Second Run from 
the Windows menu. Everything should look normal now. 

Now let's change Second Run from a love note to a letter to Mom. 
Start by changing the program name; double-click on "Second_Run" to 
select it and type: 

Dear_Mom 
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Next, change the comment; triple-click on the comment line and type 

{This program writes a letter.} 

Now select the line where Your_ name is declared and replace it with 
this declaration: 

How_much: integer; 

On to the program body. Insert the cursor after begin, press !Return! 
once, and type these procedure calls: 

HideAll; 
Show Text; 

Now select the first two writeln statements and !Backspace! them away; 
you won't need them in this program. Change the variable name in the 
readln statement so it looks like this: 

readln (How_much); 

Now take the remaining writeln statement and erase (select/IBackspacel) 
everything between the first and last quote marks, so all that remains is a 
generic writeln: 

writeln ("); 

Checkpoint - your program-in-transition should look like this. (The 
window is still called "Second Run" because you haven't resaved the 
program with a new name yet.) 

D 
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program Dear _Mom; 
{This program writes a letter.} 

vor 
How_much: integer; 

begin 
HideAll; 
ShowText; 
readl n(How_much); 
write l n("); 

end. 



Clear 

using the 
clipboard 

keyboard 
shortcuts 

WH 
WC 
WU 

Select All WA 

Session 2: Tools and Tricks 

You'll need one generic writeln for each line of your letter, with the 
text of that line inserted between the quotes. There's a tool for mass­
producing these writelns hidden up in the Edit menu. Select the entire line 
to be replicated with a triple-click; then select Copy from the Edit menu. 
You just made a copy of that line, but you can't see it, because it's hidden in 
the invisible clipboard. You can paste that copy anywhere you want in your 
program by putting the insertion bar at the desired spot and selecting Paste 
from the Edit menu. Put the insertion bar at the beginning of end and select 
Paste. Then select Paste again. Each time you paste, you'll see a new 
writeln added to your program. 

You don't need to go to the menu each time you paste, though. Try 
holding down ~ - called the command key - and pressing the "v" key. 
That keyboard shortcut has the same result as selecting Paste from the 
menu. As it turns out, many of the commands in the pull-down menus can 
be activated by using the command key with some other key. The keyboard 
commands are usually shown in the menus to the right of their mouse 
equivalents. Use ~-v to paste ten more writelns into your program. 
Then, line by line, insert text between the quote marks so your letter reads 
like this: 

writeln ('Dear Mom,'); 
writeln; 
writeln ('Due to circumstances'); 
writeln ('beyond my control,'); 
writeln ('l"m broke!'); 
writeln ('My rent is due.'); 
writeln ('My car payment is due.'); 
writeln ('Please send me'); 
writeln ('$', How_much:3,'.'); 
writeln ('I hope you're fine.'); 
writeln; 
writeln ('Love,'); 
writeln ('Skip'); 

(Notice as you're editing that three of these lines don't quite follow the 
pattern of the others; two are empty writelns for producing blank lines, and 
one includes mention of the variable How much between quoted 
punctuations.) -

The copy command can be used to copy anything you can select, from 
a single character to a whole program. Try selecting three lines starting with 
the 'f'm broke!' line (triple-click on that line and drag down), then press 
~-c to copy those four lines into the clipboard. (This action wipes out 
the previous contents of the clipboard, which can only handle one chunk of 
text at a time.) Now paste those three copied lines into a spot right before 
the 'Please send .. .' line, and change the second 'I"m broke' to 'I repeat:', 
so that section of the program now reads 
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writeln ('l"m broke!'); 
writeln ('My rent is due.'); 
writeln ('My car payment is due.'); 
writeln ('I repeat:'); 
writeln ('My rent is due.'); 
writeln ('My car payment is due.'); 

To make the letter a bit less heavy-handed, you might prefer to have it start, 
rather than end, with 'I hope you're fine.' It's easy to move that line up; 
just select it (triple-click), choose Cut from Edit (or use @L]-x), move the 
insertion bar right before the 'Due to circumstances' line, and paste. Cut, 
like Copy, puts the selected text in the clipboard; the only difference is that it 
deletes the selection at the same time. (Cut, Copy, and Paste can also be 
used to transfer text between different programs, and even between different 
Macintosh applications. The clipboard always remembers what you've put 
there until you clip something new there or shut the computer down.) 

It's taken so long to write the letter that your payments have lapsed, so 
let's change all of those "My ... payments are due" to sentences to read "My 
... ~ayments are overdue." We could edit those lines using the techniques 
we ve already covered, but there's a way to do all of those changes at once. 
Select "What to Find .. .'' from the Search menu, and you'll see this dialog 
box: 

Search for J 
!===:===================================================:::: 

Replace with J 
'--~~~~~~~~~~~~~~~~~~--' 

® Separate Words 

0 All Occurrences 

@Case Is lrreleuant 

0 Cases Must Match 

OK 

Cancel 

Type "due" in the "Search for" box, press Tab to move to the 
"Replace with" box, type "overdue", and click OK. Toward the bottom of 
the window, notice that "Separate Words" and "Case is Irrelevant" are 
bulleted, indicating that those are the operative rules, unless you specify 
otherwise. "Separate Words" means that due must be in a word by itself to 
be changed to overdue; dues or residue wouldn't be recognized or changed. 
"Case is Irrelevant" says that the capitalization is not a factor in the search. · 
Don't change anything; just click OK. When the box goes away, select 
Everywhere from the same menu. Another dialog box appears, giving you 
a last chance to change your mind: 
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Click the circled Yes button, or just press I Return I to indicate that the 
circled option is your choice. When you've got a 500-line program full of 
misspelled identifiers, this search-and-replace tool can save lots of time. 
But it can also become search-and-destroy if you don't think through all of 
the implications of your request before you press OK. For example, you 
may not have wanted to change 'Due to circumstances' to 'overdue to 
circumstances' in the first line, but you just did. (We led you astray again; 
case was relevant.) It's easy to correct that oversight - use any of the 
editing tricks you've learned. But imagine having to correct it 75 times! 
The Replace option in the same menu is a safer tool for cautious changes; it 
searches out the next occurrence of the word in question and replaces it with 
the substitute word. Find is like Replace, except that it doesn't make any 
substitutions. It's useful for finding needles in your larger haystacks. 

By now you can't see the whole program at once, because it 
overflows the window. Most of the programs you'll be writing will be 
much longer than this one, so it's important for you to learn how to scroll 
the window up and down through the program using the scroll bar along 
the window's right edge. Move your pointer to the arrow that points up 
(IQj), press the button, and hold it down. Your program will start scrolling 
through the window, with the white scroll box moving up the scroll bar like 
a tiny elevator to show you the position of your window relative to the 
overall listing. Now scroll back down with the down-arrow(~). 

It's also possible to drag the scroll box to a different ~osition on the 
scroll bar without using the arrows, or move it one window s worth with a 
click on the gray part of the bar between the scroll box and the arrow that's 
pointing the direction you want to go. Experiment. Most Macintosh 
windows have scroll bars that work just like this one. 

Scrolling is handy, but it's often inconvenient if you're trying to 
examine many lines of code at the same time. Since you can't put more 
lines in by making the window taller, the only alternative is to make the 
characters shorter, using the Font Control option from the Windows menu. 

Font Control 

OK ) ( Cancel 

® Program Windows 

program sBmple; 

IGeneua-12 

O Te Ht Window 

( NeHt J 
( Preu J 

~ 
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When you select this option, a dialog box appears, allowing you to 
indicate your font (typestyle) preference for characters that appear in the 
program and text windows. The window initially indicates that your 
program window displays characters in the 12-point Geneva font. By 
clicking the Prev button, you can select the next-smallest available size of 
the Geneva font - probably 9-point. Browse through other fonts available 
in the system file by clicking the Next and Prev buttons. Some fonts, like 
Times, Helvetica, and Courier, are designed to look best when printed on 
Apple's LaserWriter printer. Others, like Chicago and Geneva, look best on 
the Mac screen or the Imagewriter. If you select a mono-spaced font like 
Monoco or Courier, all characters in the window will take up the same 
horizontal width, as they do on typewriters and most computer screens. 

Since many Pascal programs are designed to produce columns of facts 
or figures, and columns are difficult to align using proportionately-spaced 
fonts like Geneva, Mac Pascal's text window is set up to display output in 
Monoco-9. But you can change this, too, by clicking the Text Window 
button and choosing a different font for that window.* When you're happy 
with your choices, click OK and take another look at your program. If all is 
well, you should be looking at something like this: 

program Dear_Mom; 
{This program writes a letter.} 
var 
How_much: integer; 

begin 
HideAll; 
ShowText; 
readln(How_much); 
writeln('Dear Mom,'); 
writeln; 
writeln('I hope you"re fine.'); 
writeln('Due to circumstances'); 
writeln('beyond my control,'); 
writeln('l"m broke!'); 
writeln('My rent is overdue!'); 
writeln('My car payment is overdue!'); 
writeln('I repeat:'); 
writeln('My rent is overdue!'); 
writeln('My car payment is overdue!'); 
writeln('Please send me'); 
writeln('$', How_much: 3, '.'); 
writeln; 
writeln('Love,'); 
writeln('Skip'); 
end. 

* Hundreds of fonts are available, but you'll only see the ones that have been included in 
your system file. If you want one that's not there, you'll need to install it using the 
Font/DA Mover utility, the same program that's used to add or remove desk accessories. 
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If your program looks OK, check it with the Check option in the Run 
menu. When it passes, select Go to see if it displays the letter correctly in 
the text window. 

It won't, of course, until you give it the input it's waiting for: the 
number called How _much. Type in any whole number you like, press 
I Return I, and watch the letter appear. 

Oops! Even if your program works perfectly, it's going to be hard to 
read the output in that tiny text window. You could scroll backward and 
sideways using the scroll bars to see the rest of it, but there's a better way. 
Grab the little size box in the lower right comer of the window and drag it 
straight down. The window stretches toward the bottom of the screen, 
making room for the missing lines of your letter. You can also use the size 
box to make the window wider, but you'll have to move the window to the 
left first by dragging the title bar. Play with the size box until you get a nice 
fit. 

0 Te Ht 
500 
Dear Mom, 

I hope you're fine. 
Due to circumstances 
beyond my control, 
I'm broke! 
My rent is overdue! 
Hy car payment is overdue! 
I repeat: 
My rent is overdue! 
My car payment is overdue! 
Please :send me 
$500. 

Love, 
Skip 

It's not practical to mail the computer screen to Mom, so you're going 
to need to get a paper copy of your output. Select Preferences from the 
Windows menu, click the box that says "Output also to the Printer", and 
click OK. Now when you run your program and type in an amount, the 
letter should appear in the text window and on paper (if the printer is 
ready). 

When you print your letter, you'll notice that it's got an unwanted line 
at the top: the How much figure you typed in. Later in this book you'll 
learn how to assign tlie printer to a different file identifier so you can keep 
your printed output separate from interactive input. Until then, you and 
Mom will just have to be patient. 

Save this program as "Dear Mom" on your document disk. There'll 
be a "Dear Mom" icon waiting for you when you return to the desktop, but 
you're done with this program for now. So click anywhere in the program 
window to activate it and select Close from the File menu to clear it from the 
screen and memory. 
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Before we exit to the finder, let's take a scenic side trip with a 
graphics program. There's really nothing different about running graphics 
programs, except that they're often more difficult to understand because 
they contain so many procedures with numeric arguments. Macintosh 
Pascal includes two useful tools for slowing the action down in a program 
so you can watch the play-by-play at your own pace. 

If you don't have the Oh! Mac Pascal! disk, select New from the File 
menu and type in one of the ready-to-run graphics programs from this 
chapter. If you have access to the disk, select Open, rather than New, and 
use the Drive and Eject buttons in the dialog box to make room for it in one 
of your drives. If folders rather than programs appear in the dialog box file 
list, double-click on the folder labeled Chapter 2 to find this chapter's 
programs. (Folders are explained at the end of this session.) 

When you've got a program on the screen, select Step-Step instead of 
Go from the Run menu. This option slows down the program's execution 
enough so that a tiny hand can point to each statement as it executes. The 
action is still fast, but statements don't all run together this way. 

An even better option for observing the results of individual 
statements is Step. Each time you select Step (or type ~ -S), exactly one 
statement is executed. The pointing hand shows you where you are in the 
program, so you can compare output with program every step of the way 
while you control the pace. Both Step and Step-Step work equally well 
with text and graphics programs; they're powerful tools for understanding 
and debugging your programs. 

(You've probably noticed by now that a Pause menu appears 
whenever you run a program. It hides a Halt option that can be used to 
bring things to a stop for any reason. Depending on what you're doing, 
you may be able to restart things where they left off later. Experiment.) 

Graphics programs are fun to watch on the screen, but there comes a 
time when you need to make a paper copy of your output. The easiest way 
to do that on the Macintosh is to take a snapshot of the Drawing window. 
Click on that window, turn on your printer, and press the !!..] , I Shift I , and 4 
keys all at once. An exact copy of the window should come out of your 
printer. This trick works with any active window. If you want a snapshot 
of the whole screen - a screen dump - , press the leaps Lockj key before you 
press the other three. (You can also capture any screen as a picture file that 
can be read by many Macintosh graphics applications programs, if there's 
room on your Pascal disk, by pressing ~-lshittl-3). 

When you're ready, select Quit from File to return to the desktop. 
Your "Dear Mom" icon should be waiting there for you in the document 
window. In the File menu you'll find a way to Get Info about that, or any 
other, selected item. Select "Dear Mom" with a click; then select Get Info 
from the File menu. A new window should pop out of Dear Mom that tells 
you more about that item than you probably care to know. Most of this 
window is filled with information from Mac to you, but not all of it. 

At the bottom is an empty comment box waiting to be filled with up to 
three lines of text describing First Run. Type whatever you want, but 
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remember that the purpose of this text is to remind you (or somebody else) 
what's in Dear Mom. (You'll be amazed how quickly you'll forget.) As 
you're typing, you can use the editing techniques that you learned with 
Pascal. 

Above the comment box is a much smaller box labeled Locked. 
There's no room for typing in this box, but you can "x" it with a click. An 
"x" in the box indicates that Dear Mom is locked, and can't be thrown away 
until the "x" is removed with another click in the box. (Leave it there for 
now.) This doesn't protect a document from being replaced by another 
document with the same name, or from being destroyed by a teething 
spaniel, but it does help insure that you won't absent-mindedly erase an 
important document. Like the comment box, the lock is only helpful if you 
choose to use it. 

You don't need to open the Info window to find out how big a file is 
or when it was created; all you need to do is change the view through the 
disk window by selecting an alternative from the View menu. When you 
pull this menu down, you'll see a check mark in front of "by Icon", 
indicating that that's the way you're currently seeing the active window. 
Select "by Name", and the icons in the window are replaced by mini-icons 
followed by textual descriptions of the corresponding items on the disk, 
arranged al~habetically by name. There's some useful information here that 
you couldn t see in the icons: the amount of space each item occupies on 
the disk and the date the item was last changed. There's even a padlock in 
front of Dear Mom to remind you that it's still locked. You can select and 
open items from this list the same way you did icons. In fact, you can do 
just about anything with them that you can do with big icons, except scatter 
them randomly around in the window. View by Date, by Size, and by 
Kind give you the same list arranged in different orders. 

As you might expect, you can also open folders to see what's inside. 
Try double-clicking the System Folder. You'll find several icons, including 
System, the brains behind the operation, and Finder, the desktop organizer. 
The Imagewriter file allows your Mac to talk to the printer. These system 
files need to be available for your Macintosh to work, but you don't need to 
look at them. The system folder hides the system files from you so they 
don't clutter up your disk window. The only time you ever have to open 
that folder is when you need to tinker with some part of the system (for 
example, when you want to replace one of these system files with an 
upgraded version of the same file.) 

What the system does, you can do, too. Instead of having a window 
cluttered with icons representing several month's work, you can neatly stuff 
your work into personally labeled folders. 

Create a folder by selecting "New Folder" from the File menu. 
"Empty Folder" isn't a very useful name for a folder, so the next step is to 
rename that folder. The folder is already selected, so all you need to do is 
type a new name - "Silly Programs" - to replace the old one. If you make 
an error, correct it with the usual editing techniques. (You can change the 
names of program and disk icons the same way.) 
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Once you've created and named your folder, drag it anywhere you 
want in the window. Then drag Dear Mom over the folder until it turns 
black and release. Dear Mom is now in the new folder. Repeat the process 
with the other programs you've created. If you open the folder's window, 
you'll find those icons. 

You can put anything you want (except disks and the trash) in folders 
- even other folders. The folder is a powerful organizational aid when 
you're working with the Finder. But you'll do some file operations -
saving and opening - via dialog boxes from inside Pascal. Folders may or 
may not make a difference there, depending on which version of the system 
you're using. 

When you select Open or "Save as ... " from inside Pascal, the original 
Macintosh File System (MFS) will completely ignore folders and display in 
a dialog box a list of every file on the selected disk. The newer Hierarchical 
File System (HFS) includes folders in the list along with files, but it won't 
show you anything that's hidden inside a folder - unless you open that 
folder. When you open a folder, that folder's icon replaces the disk at the 
top of the box, and only those objects stored in that folder are visible in the 
dialog box list. You can always click the disk icon to return to the disk­
level of your hierarchy of folders and files if you need to. It's possible to 
lose files in a large hierarchy of folders if they aren't filed logically, so 
exercise care and common sense when you're naming and organizing of 
folders. 

Before you Shut Down for the day, try one last trick: drag your 
document disk icon into the trash can. You're not trashing the disk, you're 
just telling Mac to forget all about it for now. That's a handy trick for 
keeping your desktop clean, but it's also helpful if you're ever greeted by an 
"insuffident memory" message. The finder uses memory to keep track of 
all of the folders and files stored on each disk, whether those disks are 
currently in the drives or not, unless you give it permission to forget. 
(There's one situation where this trick won't work: you can't discard the 
startup disk. The startup disk is the one that contains the system files that 
Mac is currently using as its master instructions. It's usually the one you 
used to boot your Mac when you turned it on.) 

That's enough for now. There's plenty more to try, but you're ready 
now to do your own exploring. When you read about something new in 
Mac Pascal - whether it's a langua~e feature like the for loop or a 
programmer's tool like the Observe wmdow - try it out. The Macintosh 
Pascal environment is designed so you can learn by experimenting. Do it! 
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~ m Common error messages and suggested solutions 

This doesn't make sense. 
Something is out of place or an inappropriate character is on the indicated line. Examine that line 
carefully. 

R semicolon (;) is required on this line or aboue but one has not 
been found. 
If you don't find the missing semicolon in the immediate vicinity, then search backward from this point 
looking for a missing semicolon or end. 

Either a semicolon (;) or an END is eHpected following the 
preuious statement, but neither has been found. 
Find the missing part; it should be close to the indicated line. 

This does not make sense as a statement. 
Often a missing parenthesis (unbalanced parentheses) or an operator used in the wrong place. 

This formal parameter type or result type should be a named 
type or " STR I NG " , but is not. 
String[n] is not an acceptable type for a formal parameter. In general, identifiers whose types have not 
been declared in a type statement may not be used as formal parameters. 

Rn incompatibility between types has been found. 
You have tried to assign a value, variable, or expression of one type to a variable of another type. This 
error also may occur when the types of formal and actual parameters do not match. 

Too few/many parameters haue been used in a call to a 
procedure or function. 
Check to see that the number of parameters in the function or procedure call match the number of formal 
parameters. You may have to refer to the Macintosh Pascal Reference Manual or Technical Appendix to 
determine the correct number and type of parameters for the built-in procedures and functions. 

R STRING ualue is too long for its intended use. 
You have tried to read or assign more characters to a string variable than it was declared to hold. Most 
frequently this error occurs when reading from a text file into a string variable and the number of 
characters before encountering an end-of-line is greater than the declared length of that string variable. 

Floating point arithmetic eHception: Underflow occurred. 
A value has been computed that is less than the smallest number the computer can store. Check for 
multipliers whose values approach zero. 



Floating point arithmetic eHception: Diuide by zero attempted. 
A value, expression, or variable used as a divisor is zero or approaches zero. 

Floating point arithmetic eHception: Ouerflow occurred. 
You have computed a number too large to store. Declare real variables to be of type extended or work 
with smaller numbers. 

Rn error has occured while opening the deuice. 
The file directory is full. 
The disk is full. 
Try using another disk. 

Rn attempt has been made to access a file on a disk or uolume 
which is not known to the system. 
Rn attempt has been made to RESET a file which does not eHist. 
Rn attempt has been made to open a file that cannot be found. 
Insen the proper disk. The use of the OldFileName function avoids this type of problem. 

Rn attempt has been made to write to a locked file. 
Quit Mac Pascal. Select the file. Select the Get Info option in the File menu and click the lock box to 
unlock the file. 

Rn attempt has been made to write to a locked uolume. 
Eject the disk and move the write protect tab to cover the opening. 

Rn attempt has been made to create a file with the same name 
as a file that already eHists. 
Pick a new file name. The use of the NewFileName function avoids this type of problem. 

,~ .. 

The Bomb 
When the bomb appears a serious error has occurred. Typically your program is too large for the 
available memory. Often the program itself isn't too large, but it calls too many built-in Mac Pascal 
procedures and functions from inside a single module, so these procedures and functions combine to 
overflow memory. To avoid the problem, keep your program and its modules as small as possible. 
Comments longer than twenty lines can cause bombs, too. If the bomb appears each time you open the 
program file you may need to use the editor utility or a word processor to get rid of long comments (or 
write your own text processing program that deletes long comments). If all else fails, try running your 
program with a fresh Macintosh Pascal disk. 

My errors and solutions: 
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Macintosh Pascal Reserved Words 

and array begin case const div 
do down to else end file for 
forward function goto if in label 
mod nil not of or otherwise* 
packed procedure program record repeat set 
string* then to type until uses* 
var while with 

Macintosh Pascal Defined Types 

real double* extended* integer 

* non Standard 

Mac Pascal Implementation-Defined Values 

32767 MAXINT 
-32767 least integer 

2,147,483,647 MAXLONGINT 
3.4 x lQ38 greatest real 
1.2 x 10-38 real closest to 0 ('least' real) 

7 real 
15 double significant digits 
19 extended 

10 ~eta! default field widths 
8 zn eger 

65535 maximum set cardinality 
ASCII character set 

97 ord('a') 65 ord('A') 48 ord('O') 

Non Standard Extensions and Limits 

(* comment *) for {comment} 
_(underscore) is allowed in an identifier 
upper- and lower-case characters are identical 
set of character is OK 
blanks truncated at end of line 
255 character maximum identifier length 

longint* string* char boolean 

Output Format 

writeln(SO : 2, 'HI': 5, -7 .933e+47 : 13); 
writeln(81.4: 5: 1, 610.22: 9: 2, -817.0: 10: 3); 

D Te Ht 
50 Hl-7.9330e+47 
81.4 610.22 -817.000 

Local Implementation Notes 
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